
Mac OS 8.5 
Installation Manual 





K Apple Computer, Inc.
© 1998 Apple Computer, Inc. All rights reserved.

Under the copyright laws, this manual may not be copied, in whole or in part, without the written consent of Apple. 
Your rights to the software are governed by the accompanying software license agreement. 

The Apple logo is a trademark of Apple Computer, Inc., registered in the U.S. and other countries. Use of the 
“keyboard” Apple logo (Option-Shift-K) for commercial purposes without the prior written consent of Apple may 
constitute trademark infringement and unfair competition in violation of federal and state laws.

Every effort has been made to ensure that the information in this manual is accurate. Apple is not responsible for 
printing or clerical errors.

Apple Computer, Inc. 
1 Infinite Loop
Cupertino, CA 95014-2084
408-996-1010
http://www.apple.com

Apple, the Apple logo, AppleTalk, Macintosh, Mac, OpenDoc, PowerBook, PowerTalk, and QuickTime are 
trademarks of Apple Computer, Inc., registered in the U.S. and other countries.

At Ease, Disk First Aid, Extensions Manager, and Finder are trademarks of Apple Computer, Inc.

Acrobat and Adobe are trademarks of Adobe Systems Incorporated or its subsidiaries and may be registered in 
certain jurisdictions. 

PowerPC is a trademark of International Business Machines Corporation, used under license therefrom.

Netscape Navigator is a trademark of Netscape Communications Corporation.

Other company and product names mentioned herein are trademarks of their respective companies. Mention of 
third-party products is for informational purposes only and constitutes neither an endorsement nor a 
recommendation. Apple assumes no responsibility with regard to the performance or use of these products.

Simultaneously published in the United States and Canada.



3

Contents
1 Welcome to Mac OS    5

System Requirements    5

2 Installing the Mac OS    7

Before You Begin    7

If You Have a PowerBook    7

Start Up From the Mac OS CD    8

If You Can’t Start Up From the CD    8

Installing the Software    9

For Help During Installation    9

3 After Installing the Mac OS    11

Using the Mac OS Setup Assistant    11

Using the Internet Setup Assistant    12

For Help With Internet Settings    12

Registering With Apple    12

Adding or Removing Software    13

4 Learning About the Mac OS    15

What’s New in the Mac OS    15

Getting Help With the Mac OS    15

Reading Late-Breaking News    16

On the Internet    16

5 Troubleshooting    17

Problems During Installation    17

Problems Using the Mac OS    21



4 Contents

Resolving Software Conflicts    22

Step 1: Verify the Problem    22

Step 2: Test Individual Extensions and Control Panels    23

Performing a Clean Installation    24

Problems Setting Up Internet Access    25

Problems Creating an Internet Account or Connecting    26

Problems With Your World Wide Web Browser    28



5

C H A P T E R

1
1 Welcome to Mac OS

System Requirements

To install the Mac OS, your computer must have

m a PowerPC™ microprocessor

m at least 16 megabytes (MB) of random-access memory (RAM); 24 MB recommended

Note: You cannot use this version of the Mac OS if your computer has been upgraded with a 
PowerPC processor card but still has a 68040 (or earlier) processor that is accessed during 
startup.

If your computer has less than 24 MB of built-in RAM, you must use virtual memory. ( Virtual 
memory is turned on automatically after installation.)

If you don’t know how much RAM your computer has, open the Apple (K) menu and 
choose About This Computer (or About This Macintosh). Look at the number next to Built-in 
Memory.

To install the recommended software, you need at least 150 MB of free space on your hard 
disk. To install the optional components, you need more than 150 MB of free space. The 
exact amount of space needed varies for different computer models, hard disk sizes, and the 
optional software you choose to install. The Installer will display a message if you do not have 
enough free space to install the software you select.

Tip:  Many application programs use your hard disk to temporarily store information. For 
best performance, keep at least 10 percent of your disk space free. To determine the amount 
of free space on your hard disk after you’ve installed the Mac OS, select the hard disk icon on 
your desktop, then open the File menu and choose Get Info. Look at the number next to the 
word “Available.”
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2
2 Installing the Mac OS

Before You Begin

Before you begin the installation, do the following:

m Turn off any disk-security software you have.

m If At Ease software is installed on your computer, turn it off before you install the Mac OS. 
For instructions, see the manual that came with your At Ease software or computer.

If You Have a PowerBook

If you are installing the Mac OS on a PowerBook, do the following additional steps:

m Plug the PowerBook in and use the PowerBook control panel or the Energy Saver control 
panel to set the PowerBook so it doesn’t go to sleep.

m Turn off password protection in the Password Security control panel.

You can install the Mac OS using a CD-ROM drive attached to (or built into) your PowerBook. 
Or, if you also have a desktop Mac OS computer, you can use it to install the Mac OS on your 
PowerBook using this method:

m Connect both your PowerBook and your desktop computer to a network. Insert the 
Mac OS CD in the CD-ROM drive of your desktop computer, then use file sharing to 
access the CD with your PowerBook over the network. Be sure to run the installation 
program from your PowerBook, so that the Installer can detect the model of PowerBook 
you’re using.

Note: Installing the Mac OS on a PowerBook in SCSI disk mode is not recommended. When 
the PowerBook is in SCSI disk mode, the Installer can’t detect that it is installing onto a 
PowerBook, and will install software for the model of desktop computer you’re using. ( You 
can perform a universal installation, but this won’t install the optimal set of software for your 
model of PowerBook.)

Warning  PowerTalk is not compatible with this version of the Mac OS. Before installing 
the Mac OS, save your PowerTalk messages as text. Open a message you want to save, 
then open the File menu and choose Save As Text.
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Start Up From the Mac OS CD

Before you install the software you should start up your computer using the Mac OS CD. This 
ensures that any incompatible extensions you have on your computer will not cause 
problems during installation.

To start up your computer from the Mac OS CD, follow these steps:

1 Insert the Mac OS CD in your computer’s CD-ROM drive.

2 Shut down your computer.

3 Turn on your computer while holding down the C key on your keyboard.

Your computer starts up from the CD-ROM disc. Continue holding down the C key on your 
keyboard until you see the screen with the smiling face. 

Note: If you have a PowerBook 1400, you need to hold down the x (Command), Option, 
Shift, and Delete keys instead of the C key. 

You’ll know you’ve started up from the CD when the desktop pattern on your screen shows a 
lot of circles that look like CDs. For more help starting up from the CD, see page 17.

If You Can’t Start Up From the CD

If you don’t have an Apple-brand CD-ROM drive, or you’re accessing the CD from your 
PowerBook using file sharing, you won’t be able to start up from the CD, but you can still 
install the software. Follow the instructions in “You can’t start up the computer using the 
Mac OS CD.” on page 17 before continuing with the installation.
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Installing the Software

After you’ve started up your computer using the CD, or followed the steps if you can’t start 
up from the CD, you use the Mac OS Installer program to install the software.

m To begin installation, double-click the Mac OS Install icon.

After a moment, a screen appears describing the installation process.

When you’re ready to begin, click Continue. The Mac OS Installer guides you through the 
steps necessary to install the software. 

For Help During Installation

m Click the Help button (h) in the upper-right corner of the window.

m See “Problems During Installation” on page 17.

For information about performing a custom installation, see “Adding or Removing Software” 
on page 13. For information about performing a clean installation, see “Performing a Clean 
Installation” on page 24.

Click to display 
more information 
about each step.
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3
3 After Installing the Mac OS

After you install the Mac OS, you can easily set up your computer and prepare it to connect 
to the Internet by using the Mac OS Setup Assistant and the Internet Setup Assistant. 

If you want to install additional pieces of the Mac OS, or you want to remove some of the 
software, you can do so by using the Customize feature of the Mac OS Installer.

Using the Mac OS Setup Assistant

The Mac OS Setup Assistant makes it easy to set up your computer. The assistant asks 
questions about you, your location, and the settings you want for your computer, then 
configures your computer using the answers provided.

1 If necessary, open the Mac OS Setup Assistant.

If you’ve just installed the Mac OS, the Setup Assistant appears onscreen when you restart 
your computer. Or, you can open it yourself by double-clicking its icon in the Assistants 
folder on your hard disk.

2 Follow the onscreen instructions.
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Using the Internet Setup Assistant

After you finish with the Mac OS Setup Assistant, you can use the Internet Setup Assistant to 
set up your computer for Internet access. 

If your computer was already configured for the Internet before installing the Mac OS, your 
previous settings were not modified by the standard installation process and you do not 
need to use the Internet Setup Assistant.

1 If necessary, open the Internet Setup Assistant.

When you’re done with the Mac OS Setup Assistant, you can open the Internet Setup 
Assistant automatically. Or, you can open it by double-clicking its icon in the Assistants folder 
on your hard disk.

2 Follow the onscreen instructions.

For Help With Internet Settings

For help using your computer with the Internet, follow these steps:

1 Open the Help menu and choose Mac OS Help.

Note: If you don’t see Mac OS Help in the Help menu, make sure the Finder is active by 
choosing it from the Application menu in the upper-right corner of the screen.

2 In the Mac OS Help contents, click “Internet and Networking,” then click the topic you want 
help with.

Registering With Apple

If you have Internet access, double-click the “Register with Apple” icon installed on the 
desktop to register your purchase.
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Adding or Removing Software

After you’ve been using the Mac OS for a while, you might decide that you want to add 
software that you didn’t initially choose to install, or you might want to remove software that 
you’re not using.

Follow the instructions in this section if you want to

m reinstall all or part of the Mac OS

m add software products you didn’t initially choose to install

m remove some software installed with the Mac OS

m install additional basic components, such as printer drivers

1 Start up from the Mac OS CD, open the Mac OS Installer program, and follow the onscreen 
instructions.

Refer to the instructions in Chapter 2 for details about these steps.

If you’ve previously installed this version of the Mac OS on the destination disk, the Installer 
asks if you want to reinstall the Mac OS or if you want to add or remove software.

2 Select an option.

m If you want to reinstall the basic system software, click Reinstall. This is the same as 
installing the Mac OS for the first time. For instructions, see “Installing the Software” in 
Chapter 2.

m If you want to add new software, or remove software you have installed, click the 
Add/Remove button. Then follow steps 3–5.
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Note: Your screen may display different choices from the ones pictured below. 

3 Click to select a software component, then open the “Installation mode” pop-up menu and 
choose Customized Installation or Customized Removal.

A list of the available components for the software product appears.

4 Select the components you want to install or remove.

To get additional information about each component, click the box with the letter i in it.

Tip:  You can see and select individual features within each component by clicking the arrow 
to the left of the component. 

5 When you’re ready to install and remove all the software you selected, click Start.

If you see messages about problems with your hard disk, see “Problems During Installation” 
in Chapter 5.
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4
4 Learning About the Mac OS

You can learn about the changes and new features in this version of the Mac OS, and how to 
make the most of your computer, by using the onscreen Mac OS Help. 

What’s New in the Mac OS

To learn about new features and changes in the Mac OS, follow these steps:

1 Open the Mac OS Read Me Files folder on your hard disk.

2 Double-click the “What’s New in Mac OS” icon.

Mac OS Help opens and displays information about the new features. To learn about a 
particular feature, click any blue underlined text.

Getting Help With the Mac OS

The Help menu is your main source of “how to” information about the Mac OS. Many 
application programs also have onscreen help.

To view onscreen help, switch to the program you want to use, then look in the Help menu.
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Reading Late-Breaking News

If you have questions about compatibility or other late-breaking news about your software, 
refer to the Read Me documents in the Mac OS Read Me Files folder on your hard disk and 
the Mac OS CD-ROM disc.

For the latest information about the Mac OS, including troubleshooting and compatibility 
tips, see the following URL:  http://www.apple.com/macos/

On the Internet

For information about the Internet software included with the Mac OS, see the Internet 
resources supplied by the manufacturers of the software.

Software Web address

Adobe™ Acrobat™ Reader http://www.adobe.com/acrobat/

Apple Mac OS http://www.apple.com/macos/

Apple QuickTime http://www.apple.com/quicktime/

Apple Support http://www.apple.com/support/

Microsoft Outlook Express http://www.microsoft.com/ie/mac/oe/

Microsoft Internet Explorer http://www.microsoft.com/ie/mac/

Netscape Navigator™ http://www.netscape.com/navigator/
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5
5 Troubleshooting

If you encounter problems when installing or using the Mac OS, read this chapter for 
common solutions.

Problems During Installation

This section helps you solve problems you may encounter while installing your software.

You can’t start up the computer using the Mac OS CD.

Cause 1: Your computer located the system software on your hard disk before it located the 
system software on the CD. If you have an external hard disk with system software, the 
computer may locate and start up from that device instead of the CD-ROM disc.

Solution 1: With the CD inserted, open the Startup Disk control panel and click the CD icon 
in the Startup Disk window. Then restart the computer. 

After you install the software, use the Startup Disk control panel to reselect your hard disk, 
then restart your computer.

Cause 2:  You don’t have an Apple-brand CD-ROM drive, or you’re accessing the CD from a 
PowerBook using file sharing.

Solution 2:  To ensure a smooth installation, turn off any virus-protection software you have 
installed. Then follow the steps in this section to temporarily disable all non-Apple extensions 
and control panels so they won’t cause problems during installation.

If you are using System 7.5 or later, use the Extensions Manager control panel to turn off
non-Apple extensions and control panels. In the Extensions Manager, open the Sets pop-up 
menu and choose the item that has the word “base” and the version of system software 
currently installed on your computer. (If you have System 7.5, choose the item that has 
“system” in it.) Then restart the computer. 
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If you are using an earlier version of system software, or don’t have the Extensions Manager, 
do the following:

1 Open the System Folder, then open the Extensions folder.

2 Drag any non-Apple extensions out of the Extensions folder and onto the desktop.

If you don’t know where a particular extension came from, click it once to select it, then 
open the File menu and choose Get Info. If the Version section of the Info window doesn’t 
say “Apple Computer, Inc.,” drag the extension to the desktop.

3 Open the Control Panels folder.

4 Drag any non-Apple control panels out of the Control Panels folder and onto the desktop.

As in step 2, use the Get Info command if you’re not sure whether to remove a control panel.

5 Restart your computer.

After you’ve finished installing the software, you can drag the extensions and control panels 
back to your System Folder. To make sure the software is compatible with this version of the 
Mac OS, restart your computer after you reinstall each item.

The Installer cannot repair your hard disk.

Cause: The Mac OS Installer is unable to repair your problem. 

Solution 1: If you see a message that the disk can’t be fixed because a file is open, quit all 
programs. If file sharing is on, turn it off. Then try installing again.

Solution 2: Use Disk First Aid, provided on the Mac OS CD, to see if it can repair the disk.

Solution 3: Use a third-party disk repair utility to see if it can repair the disk.

If you don’t have a third-party utility, or if that utility can’t repair the disk either, you may 
need to reinitialize the hard disk.

First, back up your hard disk because reintializing erases everything on the disk. Then use 
the Drive Setup utility program to reinitialize the disk. If your hard disk is not an Apple hard 
disk, use the disk utility software provided by the manufacturer instead of Drive Setup.

You can find Drive Setup in the Utilities folder on the Mac OS CD. To reinitialize your startup 
disk (the disk with system software on it), you need to start up the computer from the 
Mac OS CD. See “Start Up From the Mac OS CD” on page 8 for instructions. For help with 
Drive Setup, open the program, then look in the Help menu.

After you’ve reinitialized the disk, use the Mac OS Installer to reinstall system software, then 
reinstall your application programs. 

Warning  If you use Norton Utilities, make sure you have version 3.5.2 or later. Earlier 
versions may damage data on Mac OS Extended format disks.
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The Installer cannot update the hard disk driver.

Cause 1: You don’t have an Apple-brand hard disk or you don’t have an Apple-brand 
computer.

Solution 1:  Use the disk utility recommended by the manufacturer of your computer or hard 
disk to update the drivers on your system before installing the Mac OS. Make sure to get a 
version of the utility that is compatible with the software you are installing. An old utility will 
not be able to update your disk with the most current driver.

Cause 2: You’ve previously updated your Apple hard disk with a non-Apple disk utility. 

Solution 2: You need to use the utility you used previously to update the driver again. To 
ensure a successful update, obtain the latest version of the utility from the manufacturer. 

Cause 3: Some hard disks must be reinitialized before you can update the driver.

Solution 3: Reinitializing your hard disk will completely erase the disk. Be sure to back up all 
the files on the hard disk before proceeding. For instructions on reinitializing the hard disk, 
see the manual that came with your computer, but use the Drive Setup program provided on 
the Mac OS CD to perform the initialization, even if another Apple program was supplied 
with your computer.

You see a message that there’s not enough memory to use the Installer.

Cause 1: You didn’t start up the computer using the Mac OS CD-ROM disc.

Solution 1: See “Start Up From the Mac OS CD” on page 8. If you can’t start up from the CD, 
quit all open applications and make sure you’ve followed the steps described in “If You Can’t 
Start Up From the CD” on page 8.

Cause 2: Your disk cache or RAM disk setting is set too high in the Memory control panel.

Solution 2: Open the Memory control panel, set your disk cache to the lowest possible 
setting, and reduce or turn off your RAM disk. Then restart the computer. 

You see a message that your computer doesn’t have enough memory to use 
the software. 

Cause: Your computer has less RAM than is required to use this version of the Mac OS.

Solution: For memory guidelines, see “System Requirements” on page 5. If necessary, 
contact your computer dealer for information about how to purchase additional memory.
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You see a message that there’s not enough disk space.

Cause: Your computer’s hard disk has too little space available to install the software.

Solution: Make more space available on your hard disk by removing some files from the 
disk. Make backup copies of the files you want to keep. Then drag them to the Trash and 
choose Empty Trash from the Special menu to delete the files. You don’t need to quit the 
Installer before you remove files from the disk. 

When you see this message, some of the software you selected may have been successfully 
installed. The Install Software window in the Installer program indicates which software has 
already been installed.

You see a message that the System file cannot be modified. 

Cause 1: You have installed virus-protection software that guards against modification of the 
System file.

Solution 1: Start up your computer from the Mac OS CD, as described on page 8.

Solution 2: Drag any virus-protection software out of the System Folder and restart your 
computer. You can put the virus-protection software back after installation.

Cause 2: The System file or the Finder file may be locked.

Solution 2: To see if your System file or Finder file is locked, select the file’s icon. Then open 
the File menu and choose Get Info. Make sure the Locked checkbox is not selected.

You see a message that an item cannot be replaced. 

Cause: The Installer is attempting to replace a file, but there is a folder on the disk that has 
the same name as the file being replaced.

Solution: Find the folder on your disk and rename it, then try the installation again.

You see a message that the installation was not successful. 

Cause: You may have an incompatible item in your System Folder. 

Solution 1: Start up your computer from the Mac OS CD, as described on page 8.

Solution 2: If you have a non-Apple CD-ROM drive and can’t start up from the CD, make 
sure you do all the steps described in “You can’t start up the computer using the Mac OS 
CD.” on page 17.
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Problems Using the Mac OS

This section helps with problems you may encounter using the computer after you have 
installed the Mac OS.

You can’t start up or restart the computer, or when you do you see a bomb 
message.

Cause 1: You probably have an incompatible item in the System Folder.

Solution 1: Follow the instructions in “Resolving Software Conflicts” on page 22.

Cause 2: Your system software may have been damaged. 

Solution 2: Reinstall system software by following the instructions in “Performing a Clean 
Installation” on page 24.

Application programs freeze, or require you to restart the computer.

Cause: You may have an incompatible item in the System Folder, or the application program 
is incompatible with this version of the Mac OS.

Solution: Follow the instructions in “Resolving Software Conflicts” on page 22.

You may have a version of the program that doesn’t work with this version of the Mac OS. For 
compatibility information about an application program, contact the program’s manufacturer. 

None of your network devices appear in the Chooser.

Cause 1: AppleTalk is not turned on.

Solution 1:  Open the AppleTalk control panel and make sure you have chosen the correct 
port in the “Connect via” pop-up menu, and that AppleTalk is turned on.

Cause 2: There is a conflict between your network number and another network number.

Solution 2:  If your network number or node number has been set to “User Defined,” turn off 
the User Defined setting in the AppleTalk control panel. Then close and reopen the control 
panel.

For complete AppleTalk setup instructions, see the “Internet and Networking” section of 
Mac OS Help, available in the Help menu when the Finder is active. 

You can’t connect to devices outside your local network.

Cause: Your router address or subnet mask has been entered incorrectly. 

Solution: Make sure your router address and subnet mask are entered correctly in the 
TCP/IP control panel. Check with your network administrator or Internet service provider for 
the correct values to enter. 

For complete TCP/IP setup instructions, see Mac OS Help, available in the Help menu when 
the Finder is active. 
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You performed a clean installation of the Mac OS and now you can’t use 
programs that require OpenDoc.

Cause: A clean installation of the Mac OS does not include the OpenDoc software required 
to use OpenDoc parts and applications.

Solution: Reinstall the OpenDoc software.

Resolving Software Conflicts

If your computer does not start up properly or behaves erratically, you probably have an 
incompatible extension, control panel, or application.

Step 1: Verify the Problem

To verify that you have a compatibility problem, follow these steps:

1 Start up your computer while holding down the Space bar.

Holding down the Space bar opens the Extensions Manager control panel during startup. 

2 Release the Space bar when the Extensions Manager appears.

3 Open the Selected Set menu and choose the item with the words “Mac OS Base.”

This turns off all extensions and control panels except those installed with the Mac OS.

4 Close the Extensions Manager control panel to continue startup.

5 When the computer is ready, try the same actions that caused the problem.

If the problem no longer occurs, you probably have an extension or control panel that 
doesn’t work with this version of the Mac OS. Continue with the steps in “Test Individual 
Extensions and Control Panels,” next, to identify the item that is causing the problem.
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If the problem still occurs, try checking your hard disk for problems with the Disk First Aid 
utility. You can find Disk First Aid in the Utilities folder on the Mac OS CD. You should also 
check to make sure that your application programs are compatible with this version of the 
Mac OS. If the problem occurs only when using a certain program, that program is probably 
not compatible. Check with the program’s manufacturer for information. 

Step 2: Test Individual Extensions and Control Panels

To test an individual extension or control panel for compatibility, follow the steps below.

1 Start up your computer while holding down the Space bar.

Holding down the Space bar opens the Extensions Manager control panel during startup. 

2 Release the Space bar when the Extensions Manager appears.

3 Turn on the item you want to test by clicking its checkbox.

4 Close the Extensions Manager to continue startup.

5 Try the same actions that caused the problem.

If the problem does not occur again, then the item is probably compatible with this version 
of the Mac OS.

If the problem occurs again, the item is probably incompatible. Open the Extensions 
Manager control panel and click the item’s checkbox to deselect it.

6 Repeat steps 1 through 5 for each item you want to test.

If you find that a piece of software is incompatible, turn it off or remove it from your 
computer, then contact the manufacturer of the software to see if an updated version is 
available.
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Performing a Clean Installation

This section provides instructions for what is commonly called a clean installation of system 
software.

A normal system software installation replaces changed system files and adds new ones, but 
leaves other files alone. A clean installation creates a completely new System Folder on your 
hard disk. 

Performing a clean installation can be a complicated and lengthy procedure, but if you are 
experiencing problems or your computer seems slow, it may help. 

1 Start up your computer from the Mac OS CD-ROM disc. See “Start Up From the Mac OS CD” 
in Chapter 2.

2 Open the Mac OS Installer application.

3 In the Welcome dialog box, click Continue.

The Select Destination dialog box appears.

4 Click the Options button.

5 Click the Perform Clean Installation checkbox to select it, then click OK.

6 Select the destination hard disk, then click the Select button.

Important  Since a clean installation creates a completely new System Folder, you must 
reinstall any non-Apple extensions, fonts, and control panels after you do the installation. 
Before you begin, write down your Internet settings (from the Modem, TCP/IP, and PPP 
control panels). If your computer came with software that was already installed, some of 
those programs might need to be reinstalled after you perform a clean installation, 
particularly if those programs rely on files that used to be in the System Folder. See the 
documentation that came with your computer for information.
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7 Click Start to begin the installation.

If you want to customize your installation, see “Adding or Removing Software” on page 13.

A new System Folder is installed on your hard disk. (The old System Folder is renamed 
Previous System Folder.) 

When the Mac OS Installer is finished, you can reinstall extensions, fonts, control panels, and 
other items not installed with the Mac OS from their original disks. If you don’t have the 
original disks, you can drag these items one at a time from the Previous System Folder to the 
new System Folder. To make sure the software is compatible with this version of the Mac OS, 
restart your computer after you reinstall each item.

After you’re sure that you’ve copied all the items you want to save into your new System 
Folder, delete the Previous System Folder from your hard disk.

Problems Setting Up Internet Access

The list of modem types in the Modem Settings window does not include the 
name of your modem.

Cause:  The script for your modem is not installed.

Solution: Copy the modem script file (CCL) supplied with your modem into the Modem 
Scripts folder in the Extensions folder. Additional modem scripts are available in the CD 
Extras folder on the Mac OS CD. If you can’t find a script for your modem, contact the 
manufacturer of the modem to get this file. Once the file is copied into the Modem Scripts 
folder, your modem will appear as a choice the next time you launch the Internet Setup 
Assistant.

You have an internal modem, but the Modem Port menu in the Modem Settings 
window does not include Internal Modem as a choice.

Cause 1:  On computers with an internal comm slot, the internal modem shows in the 
software as if it were attached to the modem port.

Solution 1: If your computer has an internal modem, but it does not appear as a choice, 
then Modem Port is the correct selection.

Cause 2:  An extension necessary for your modem is not installed or is turned off.

Solution 2:  Use the Extensions Manager control panel to turn on any modem extensions. 
You may need to reinstall the software that came with your modem if you cannot identify the 
required extension.
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Your modem appears in the list of modem types in the Modem Settings 
window, but your modem does not seem to be working. 

m Check to see that your modem is turned on and connected to your computer and to your 
phone line correctly.

m You may need to contact the modem vendor to get an updated modem script. Once you 
get this script, copy it into the Modem Scripts folder in the Extensions folder (located 
inside the System Folder). 

Problems Creating an Internet Account or Connecting

While you are attempting to create a new account, the line seems to have 
dropped or you get no response from the computer your modem has called.

Cause:  When you try to create an account, the Setup Assistant places a call to an Internet 
registration server and launches a World Wide Web browser. Sometimes the remote 
computer is busy temporarily and you can try to create the account again almost 
immediately.

Solution: Quit the Web browser application. If you see a dialog box that asks you if you want 
to continue, click Continue. Try the registration procedure again. If problems continue, there 
may be noise or static on the telephone line that is interfering with the connection. If you 
have another telephone line, try it instead.

You cannot connect to an online service using the Internet Setup Assistant.

Cause: The Internet Setup Assistant is designed to connect your computer to an Internet 
service provider. It is not designed for use with online service providers such as America 
Online or CompuServe. 

Solution: Contact the online service for software and instructions on how to set up an 
account with them. America Online software is provided on the Mac OS CD.

You see a “Trouble with Assistant” window when you attempt to connect.

m Check to make sure that the correct port is selected for your modem, and that your 
modem is turned on and connected to your computer and to an analog phone line. 

m Your modem initialization string may not be working correctly. You may need to contact 
the modem vendor to get an updated modem script.
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You cannot set up Internet access through a LAN and you used BootP or DHCP 
with your previous version of the Mac OS.

Cause: The TCP/IP settings are not correctly configured.

Solution: Use the TCP/IP control panel to configure your Internet access. If your computer 
was previously configured to use the TCP/IP control panel, you can import your old settings. 
Choose Mac OS Help from the Help menu for information about importing TCP/IP settings.

You performed a clean installation of the Mac OS and now your modem doesn’t 
work properly.

Cause: A clean installation installs the basic components of the Mac OS. It does not install 
Apple Telecom software, or third-party software that may be required to use your modem.

Solution: Reinstall the software that came with your modem.

You performed a clean installation of the Mac OS and now you can’t connect to 
the Internet.

Cause: A clean installation of the Mac OS resets your TCP/IP, Modem, and PPP settings.

Solution: Use the Internet Setup Assistant, in the Assistants folder on your hard disk, to 
configure your computer for Internet access. Contact your Internet service provider if you’re 
not sure what the correct settings are for your computer.

Mail and Browse the Internet don’t open the application programs you prefer.

Cause: The Mail and “Browse the Internet” items, in the Internet Access submenu of the 
Apple menu, use the settings in the Internet control panel to determine which programs you 
use for managing e-mail and browsing the Web.

Solution: Use the Internet control panel to select the default application programs you use 
for e-mail and Web access. See the “Internet and Networking” topic in Mac OS Help for more 
information.
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Problems With Your World Wide Web Browser

The following problems may occur when you use the Internet Setup Assistant. See the 
documentation for your World Wide Web browser or contact the manufacturer of the 
browser directly for assistance and troubleshooting information.

You see a message that your browser is “unable to create a network socket 
connection.”

Cause: Your connection to the Internet may have closed. 

Solution 1: Make sure you are connected to the Internet; redial if necessary.

Solution 2: In some cases, you may need to quit and reopen your browser.

Solution 3: Make sure the settings in your TCP/IP control panel are correct. Contact your 
Internet service provider if you’re not sure what the correct settings are for your computer.

Your Web browser “freezes” (doesn’t respond to input from the keyboard or 
mouse) whenever it’s opened.

Cause: You may need to increase the amount of RAM available to this application.

Solution 1: If your computer does not have 24 MB of RAM, then you must turn virtual 
memory on so that your RAM and virtual memory total at least 24 MB. For more information, 
see the Memory topic in Mac OS Help.

Solution 2: If you have at least 24 megabytes of RAM, you may need to quit other 
applications that you have running, and you may need to increase the amount of RAM 
available to your browser by using the Get Info command. For more information, see the 
Memory topic in Mac OS Help.

You see a message saying “This server does not have a DNS entry.”

Cause: The server that you are attempting to access may be shut down or not operating 
correctly, or your TCP/IP settings are incorrect.

Solution 1: Since the problem may be temporary, try connecting at another time. 

Solution 2: If you typed the URL (uniform resource locator) of the destination page, check 
to be sure that you’ve typed it correctly.

Solution 3: Make sure you have specified a name server address in the TCP/IP control panel. 
Contact your Internet service provider if you’re not sure which name server to use.

The Microsoft Internet Explorer plug-ins you were using before you installed 
the Mac OS are no longer working.

Cause: When the Mac OS is installed, a new Internet Explorer folder is created in the 
Internet Applications folder, located in the Internet folder on your startup disk.

Solution: Move your plug-ins to the plug-in folder located in the new Internet Explorer 
folder. 


